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1 Introduction

This document’s aim is to provide instructions on setting up, installing, and configuring the
Auditbase software. It also includes essential information on safety measures and
troubleshooting.

Auditbase consists of a number of modules reflecting working operations at a hearing Audiology
clinic.

Depending on your purchased licenses, some of the modules described in this document might
not be available in your version of the Auditbase software. Please contact your distributor to get
more information on the licenses.

The Auditbase system modules are provided with online help. To activate this function, press
F1, Shift+F1, or select Help in the menu.

Disclaimer:

This document is not intended to be a complete reference. For detailed information, please
refer to the User and Admin Guides after installing the Auditbase software.
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2 Abbreviations and terms

Term Definition

AB Auditbase

ABR Auditory Brainstem Response (a hearing test to determine how
the inner ear (cochlea) and the brain hearing pathways are
working).

BSA British Society of Audiology

OAE Otoacoustic Emissions (a hearing test to determine how the

inner ear (cochlea) is working).

QRP Technology for building reports using Team Developer
RPT Technology for building reports using Crystal Reports
IFU Instructions for Use
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3 Symbols used

Symbols are used in the system and in the documentation in places where this is required by
regulations or where it is simply more convenient due to space restrictions.

A General Warnings

M Manufacturer address

ce CE
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4 Compliance with standards

Auditbase application complies with the following standards:

Ne | Nomenclature Standard name

1 ISO/IEC 27001:2013 Information technology - Security techniques - Information
+C1:2014 +C2:2015 security management systems - Requirements
(Edition 2)

2 ISO/IEC 27002:2013 Information technology - Security techniques - Code of
+C1:2014 +C2:2015 practice for information security controls.
(Edition 2).

3 EN 60601-1-6:2010 Medical electrical equipment - Part 1-6: General
+AMD1:2013 CSV (Ed requirements for basic safety and essential performance -
3.1) Collateral standard: Usability

4 IEC 62304:2006 + Medical device software - Software life cycle processes
AMD1:201 5 CSV
(Edition 1.1),

5 IEC 62366-1:2015 Medical devices - Application of usability engineering to
(Edition 1.0) medical devices

6 ENISO 14971:2019 Medical devices - Application of risk management to medical
(Edition 3.0) devices

7 EN ISO 13485:2016 Medical devices - Quality management systems -
(Edition 3.0) Requirements for regulatory purposes

8 MDD -93/42/EEC The Medical Device Directive (Council Directive 93/42/EEC
(M5/2007) of 14 June 1993 concerning medical devices)

9 MDR (EU) 2017/745 Medical Devices Regulation (MDR)

10 | IEC 82304-1:2016 Health software — Part 1: General requirements for product

safety

11 | DCB 0129 Amd Clinical Risk Management: its Application in the
24/2018 Clinical Risk | Manufacture of Health IT Systems
Management
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5 Intended use

Auditbase is a “Hospital Information System”

e For storage and transfer of electronic patient records, archiving of documents and data
related to a specific patient.

e Various modules for recording, viewing and altering of clinical patient data.

¢ The stored information is partly intended for aiding in decision making for correct
treatment.

¢ At the same time, Auditbase is not indicated as a sole means of diagnostics.

Product name | Trade Name MDR MDR GMDN Basic UDI-DI

Class Rule
2003 Auditbase Class llb 11 61087 | 05711781DHF2003-
Auditbase 127

5.1 Intended medical population and purpose
Auditbase Audiogram module (Type 2003 Auditbase)

The Audiogram Module is used by Audiology teams in public and private Hospitals. Audiology
clinics provide services to patients with hearing loss.

The Auditbase Audiogram module is not indicated as a sole means of diagnostics.

The Auditbase Audiogram module is a software device intended for recording the
measurements of hearing loss for aiding in decision making of the correct treatment for that
hearing loss and suitability of the patient for a specific type of hearing instrument.

Auditbase Implant module (Type 2003 Auditbase)

The Implant Module is used by Implant teams in public and private Hospitals. Implant clinics
provide services to patients with profound hearing loss.

The Auditbase Implant module is not indicated as a sole means of diagnostics.

The Auditbase Implant module is a software device intended for recording the measurements
of hearing loss and speech and language discrimination for aiding in decision making of the
correct treatment for a hearing loss in the determination of suitability of the patient for a
specific type of (cochlear) implant.

Auditbase Surgery module (Type 2003 Auditbase)

The Surgery Module is used by ear surgeons in public and private Hospitals. Ear surgery clinics
provide services to patients with profound hearing loss.
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The Auditbase Surgery module is not indicated as a sole means of diagnostics.

The Auditbase Surgery module is used for recording what has been done at each stage of the
patient pathway. The Auditbase Surgery module is not used in the process of making a
diagnosis on the preferred treatment of the client’s hearing condition, it is used for manually
recording and monitoring the decisions and actions taken.

Auditbase ABR/OAE module (Type 2003 Auditbase)
The product is indicated for use by audiology teams in public and private Hospitals.
The Auditbase ABR/OAE module is not indicated as a sole means of diagnostics.

The Auditbase ABR/OAE module is used for manually recording the results of diagnostic or
screening ABR and OAE measurements. Results of the measurements may be used in the
process of making a diagnosis on the preferred treatment of the client’s hearing condition.

Auditbase Questionnaire module (Type 2003 Auditbase)
The product is indicated for use by audiology teams in public and private Hospitals.
The Auditbase Questionnaire module is not indicated as a sole means of diagnostics.

The Auditbase Questionnaire module is used for manually recording the results of audiological
questionnaires before and after treatment. Results of the questionnaires may be used in the
process of making a diagnosis on the preferred treatment of the client’s hearing condition.

5.2 Intended user profile

Auditbase audiogram module (Type 2003 Auditbase)

The Auditbase Audiogram module is typically used by the audiologist personnel in an
audiological clinic. Typical user roles are the following:

¢ Audiologists;
¢ Users in the read-only (limited view) mode, typically in not audiology departments.

Auditbase Implant module (Type 2003 Auditbase)

The Implant Module is used by Implant teams in public Hospitals. Typical user roles are the
following:

¢ Speech and Language therapists;
e Teachers of the Deaf;

¢ Audiologists;

¢ Implant surgeons.

Auditbase Surgery module (Type 2003 Auditbase)
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The Surgery Module is used by ear surgeons in public Hospitals. Typical user roles are the
following:

e Ear surgeons.
Auditbase ABR/OAE module (Type 2003 Auditbase)

The ABR/OAE Module is used by Implant teams in public Hospitals. Typical user roles are the
following:

¢ Audiologists.
Auditbase questionnaire module (Type 2003 Auditbase)

The questionnaire Module is used by Implant teams in public Hospitals. Typical user roles are
the following;:

¢ Speech and Language therapists;
e Teachers of the Deaf;

¢ Audiologists;

¢ Hearing therapists.

Other modules in Auditbase are typically used by the personnel in an audiological clinic. Typical
user roles are the following;:

¢ Clerical staff;

¢ Audiologists;

¢ Hearing therapists;

¢ Repair specialists;

¢ Trainees;

¢ System administrators.

Users in the read-only (limited view) mode, typically in not audiology departments.

5.3 Auditbase modules

Patient Information

Includes advanced search function, option to store an assessment overview for a patient,
merge of patient data, patient group definitions, GP and patient demographics, automated
notices and more.

Visit screens, history and outcome recording for Implant teams

Information recording for Implant teams

Patient tests and questionnaires
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Tests and questionnaires used by audiologists, Speech and Language Therapists and Teachers
of the Deaf.
Professional contacts including GPs

Professional contacts including GPs, Health Visitors, schools etc.

Booking module, patient communication and resource planning

Comprehensive appointment administration including advanced search function, task related
time allocation, waiting lists and appointment letters, group appointments, resource use and
link to referrals.

Referral and Waiting list
Comprehensive, configurable and intuitive Waiting list and Referral modules with start, stop
and suspend clock options to help comply with government pathway regulations.

Professional audiometry

There is the full ability to perform hearing tests using direct interfaces to manufacturer specific
measuring equipment and to equipment with Noah compatible modules. Store and retrieve
detailed measuring results including audiogram comparison using trend graphs. The
audiometry module has multiple print options. Additional features include extended
measurements, reports including audiogram and tympanometry data, detailed assessment
plan for tinnitus patients or other issues (e.g. aural rehabilitation), protocols for vestibular
testing and paediatrics

Other measurements

OAE and ABR measurements

Graphical speech

Outcome measurements for speech recognition applied in detailed graphical form with
normative curves.

Journal module

Handling of patient journals including signed and non-signed journal texts, the option to set up
auto generated journal actions, the use of journal templates, extensive formatting and text
editing based on user rights.

Task list
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Define prioritised patient related or general tasks and add reminders and other notes with
reference to an individual member of staff or in general. Alerting can be set for on screen
and/or at log in.

Treatment summary

Configurable patient overviews (e.g. selected Journal notes, audiogram picture, assessment or
paediatrics).

Paediatric module

Selection of specific paediatric features such as automatic calculation of age based on date of
birth, management of family and contact information, referrals, audiogram data and free text
consultation.

Stock module

Handling of serial number and quantity controlled items including advanced search function
and automated device issuing from Stock after fitting in Noah. Hearing instruments can be
fitted using Noah compatible modules. Use a barcode reader for fast registration of stock. Other
features include user secure editing of stock status, order and stock transaction overview as
well as purchase orders, loan and returned instruments history and ear moulds.

Barcode stock verification

Verify stock with a barcode reader for a fast and easy way of doing inventory.

Auditbase Check-in

Patients can self-register on arrival via a touch screen.

Day view

An overview of patient and other appointments per location.

Location and Department Filtering

Handling of individual locations or departments with user or workstation related waiting lists,
appointment/booking symbols, letters, stock types and documents specific to each location.
Import/export module

Electronic exchange of data for instance in connection with patient transfer to another Trust or

exchange of data with other systems for further adaptation.

Repair module
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Handling of repairs to/from external parties (standard version) and handling of internal as well
as external repairs, invoicing, expedition and more (full version).

Documents and attachments module

Handling of documents and file attachments for clients as well as those not related to clients
e.g. document templates; with the possibility of making client related documents based on
templates.

Statistical module

In depth statistics for appointments, referrals and stock.

5.4 Single current client

Global client is always maintained regardless of which module is open. This is performed using
an internal numerical patient identifier Patient ID independent of the external identifiers used
by customers and users.

5.5 Limitations and constraints for using Auditbase

¢ Auditbase must be used by users who meet the Intended user profile described above.

¢ Auditbase must be used by trained users who have read and understood this Instruction
for use.

¢ Auditbase is intended to be used in Audiological clinics.

¢ User full names registered in the system must be unique because Noah does not work for
users with duplicated names.
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6 Precautions and safety

6.1 Warnings, precautions and contraindications

A Be sure to observe the safety requirements stated in this instruction, both during
installation and use of this system.

Be warned that Auditbase is intended to be used as part of an overall diagnosis and
treatment process. Decisions should not be taken which could affect the safety of
patients without reference to other ways and methods of assessment. Any findings
should be confirmed with the patient before taking action and users should be alert to
confirm any data with the patient which they suspect of being incorrect.

The system the user is using has to fulfill the minimum system requirements in order to
mitigate the risk that patient data cannot be read for the database where network latency
is too high or the screen does not fit all the data where screen resolution is too low.

PAS update: please ensure the client is the same as requested before saving.

To avoid unauthorized persons accessing the system, make sure your password is secure
enough in terms of length, complexity, and unpredictability and do NOT disclose it to
anyone.

For security, the System Administrator password must be changed at first use and must
only be shared with persons nominated to make configuration changes. This password
must be changed on a regular basis.

If you have forgotten your password, you must contact your System Administrator
immediately to change it. If you think you may have lost a record of it and someone else
could have found it, then you must inform your System Administrator immediately.
Double check you are assigning/associating correct rights/role, otherwise users can
make inappropriate actions in the system.

To prevent unauthorised access to patient data users must not leave their PC
unattended.

General search for a Client: be careful when exporting to CSV the results of client search
as you might be running the risk of a PID (patient identifiable data) leak.

When using Noah Fast data view, do not forget to close the Fast Data View document
manually since Auditbase cannot close it automatically. Be careful with patient content,
Auditbase cannot warn users that a Fast Data View document is still opened for a client
when users select a second client.

On the Client information screen, please ensure the e-mail address is correct; entering an
incorrect e-mail can cause sending the client's data to a wrong addressee.

Auditbase is intended as a system for all patients from young children to elderly adults.
There are no contraindications indicating any groups of patients that it should not be
used with.

Users exporting the Onward referrals list to CSV must proceed with care when processing
the file to avoid the loss/leak of patient data.
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¢ Patient medical notifications must not be used as a single diagnostic tool. When onward
referring a patient for further treatment, such notifications must be reviewed by qualified
personnel alongside other patient data before any action is taken on the patient.

¢ Auditbase functioning cannot be impaired when the software is used with other medical
devices such as cardio stimulators, high-frequency electro-surgery units, defibrillators,
shortwave therapy equipment etc., and does not endanger the patient. Additional
equipment that can be used with Auditbase must comply with the requirements of IEC
60601-1.

¢ Auditbase can work in combination with printers and barcode scanners. Auditbase will
work safely with them and will not impair the specified performance of the devices where
standard Windows drivers and software are used. There is a restriction that barcode
scanners must be able to simulate typing on the keyboard and must be able to produce
prefix and suffix additions to the information string.

¢ |t is essential that the Business Process ensures that training is in place to all users
before starting to use Auditbase.

¢ |tis essential that the Business Process ensures that adequate resources are provided
for client PCs according to the minimum system requirements. The Auditbase pre-install
or pre-upgrade checklist must be accurately completed.

¢ Electronic instructions are provided instead of paper instructions. All users have access
to the electronic version of the IFU available from the application itself. Users with access
to a printer can therefore print a paper copy of the IFU themselves from the application.

o If the customer requires a paper copy of the IFU, it can be provided within 7 days of the
user's request to the support@auditdata.com

0.2 Be aware

¢ BSA shadow masking symbols are not included in the Noah standard: therefore, they will
not be transferred to Auditbase on saving the audiogram in Noah.

* When working in any module, before proceeding with reporting or treatment decisions,
please make sure the correct client is selected to avoid making an incorrect report or
treatment.
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7 Installation, Setup and Operation

7.1 Installation and uninstallation

For full step-by-step guidelines on how to install the Auditbase System, refer to the
Auditbase Complete Installation Guide.

Installation must be done by or with Auditdata support personnel assistance. Installation
instructions can be found in the Complete Auditbase installation guide and Quick
Auditbase installation guide available on the release CD.

There are no specific interface system requirements to be considered at the installation
time. Optional interface requirements are available and can be discussed with your
Auditdata representative.

Uninstalling Auditbase: See Auditbase Complete installation guide.

Minimum and recommended client and server specifications are outlined in Appendix A
of this document.

7.2 Setup

The System Administrator referred to in this document uses the login SYSADM and a
given password.

A For security, this password must be changed at first use and must only be shared
with persons nominated to make configuration changes. The password must be changed
on a regular basis.

Customers are recommended to employ Active Directory integration for login to Auditbase
so that passwords are not in use, and they can employ multi-factor authentication to
secure the Active Directory login.

Immediately after the initial Auditbase installation, options for secure password
configurations and auto-logout must be considered. See the corresponding sections
below.

Dependencies on other applications: Auditbase works with MS Word for processing
documents, therefore, if processing documents is planned on the workstation, MS Word
must be installed on that workstation,

For details on how to configure Auditbase, see Auditbase Admin Guide.
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7.3 Logging on

& It is essential that the Business Process ensures that training is in place to all users before
starting to use Auditbase.

There are two ways to log into Auditbase:

¢ With an Auditbase account
¢ With a Microsoft Windows (Active Directory) account

You can use only one type of account to log into Auditbase.

To be able to log in with a Microsoft Windows account, your System Administrator should have
configured your Auditbase account to use your Windows credentials and enabled the Auto login
for Windows authentication.

1. Log in using a Microsoft Windows account

¢ Double-click on the Auditbase icon on your desktop
* Auditbase will log you in using your Windows credentials to the default database

If you want to log into a different database than the default database, you need to click the

Windows icon (E) and go to Auditdata > Auditbase with database choice.

2. Log in using an Auditbase account

¢ Double-click on the Auditbase icon on your desktop
¢ Choose your Database name (usually ABASE)

e Enter your Username and Password

e Click Login
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Version 6.0.0

o) Auditbase

€3

System is licensed to
Test customer (10 users)

Database ABASE
User

Password

AUDITDATA

ght & 2020 Auditdata. Al rights reserved

Security: The system locks out a user after some number of attempts to enter the wrong
password (configured, typically 3). A record of this event is included in the log. Unlocking the
user account must then be done by the System administrator.

2.1. Logging in for the first time

When logging in for the first time or the first time after the System Administrator has changed
your password, a message will be generated requiring you to change your password before

logging in.

Change password X
OK Cancel
Userlogin ANMNA
Passwaord
Current T
New aaaaaaaa
Repeatnew | ¥
Mote: Passwords must begin with a letter a-Z and must
conform to the strength rules in Administration.

If a quicker log in is required, your System Administrator can choose to load only the default
module at start up. This will mean that opening subsequent modules will be slightly longer.

Symbols can be saved to the local PC which will mean that log in will again be slightly quicker.
Your System Administrator can set up for the whole site, but this can be overwritten for a
particular PC in Workstation Settings in the System Administration tool.

After logging on, if Noah does not initialize properly due to poor performing PC, when the Noah
Modules navigation shortcut tries to populate or when going to open Noah, a message bar will
appear stating the problem. A retry of the Noah initialization can be attempted from here by
selecting the Reinitialise button.
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If Auditbase or Viewer is opened directly from another system which passes the account and
the password has been updated in that system and not in Auditbase, the login will fail and the
new Login dialog will appear.

You may receive a message if a licence is already being consumed by this PC. One message
where it is under your user name and you can clear it and another where it is under another
user name and you should contact the System Administrator.

Login details are linked to the signatures which are used to identify what has been done with a
patient, and by whom, throughout the database. If the Username and Title history is changed
due to a name change or job change then the signhature will be changed from the date forward
of the change. This information relates to all journal, document, stock and client related
information held within the database. The historical information is maintained the signature for
the items.

If Single Sign On is being used and has been set up for your account, double clicking the icon
will automatically log you on to Auditbase.

7.4 Logging out

From anywhere in Auditbase, not Noah, you can logout quickly by pressing F2 and the login
window appears for another user to login. The system will prompt you to save any entered or
edited data.

Pressing the F2 button also allows you to change user. This is useful if you work on a computer
where someone else is logged in.

NOTE: If you have a dialogue box opened and/or data unsaved and have logged off, it will not
be possible to change the user to another one except for Administrator.

As a System Administrator, you can log in as the previous user after the user has logged out.
When a user has logged out of Auditbase, click on Unlock. This enables you to choose the
Administrator option, where you enter your System Administrator password and then click
Unlock again. You are now logged into Auditbase with the previous user’s credentials.

When exiting Auditbase a confirmation appears Are you sure you want to exit the application?
This can be disabled in Auditbase Administration.

7.5 Password

If you mistype your user name and password more than three times, the Auditbase system will
shut down.

There is also now the option to Lock the user out of Auditbase should an incorrect password be
entered more than a certain number of times consecutively. The number of incorrect
passwords allowed is determined by the System Administrator. If a correct password is entered
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then this resets the incorrect password count to 0. Should this happen the User account will
need to be unlocked by the System Administrator.

Moreover, the System Administrator may choose to lock out accounts which have not been
logged into for a period e.g. 3 months. Should this be the case then contact the System
Administrator to unlock the account.

If you press Cancel, the login window closes and the system returns to Windows.

The system administrator manages the user name, password and expiration of password.

7.5.1 Change password

A user can change their password in Auditbase using the System settings -> Change password
menu item:

X

Laptop synchronization

= Prepare off-line database

Close current module

Show cpened modules

Current default theme k

Change password

Open systern administration

In the opened dialog, the user needs to enter the current password, the new password, and
repeat the new password:

Change password X

OK Cancel

User login SYSADM

Password

Current ||

MNew
Repeat new
MNote: Passwords must begin with a letter a-Z and

must conform to the strength rules in
Administration.

Expiry of password

When a password will expire in less than 5 days (counted from the latest change of password),
the user will be notified and asked whether to change the password now or login without
changing the password.
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If a password has expired, the user must change the password in order to access Auditbase. It
will not be possible in any way to access Auditbase without changing the password. Please
contact the system administrator to change your password.

Format of new passwords

¢ A password cannot be empty and is limited to 8 characters

¢ Old password must be entered in order to change it to a new one

¢ Passwords can only contain characters between AtoZand Oto 9

¢ The first character in a password must be a letter from Ato Z

¢ You might not be able to reuse old passwords - how far back the history goes depends on
the site setup

¢ |nthe Change password window three mistakes in a row causes the window to close

A WARNING: To avoid unauthorized persons accessing the system, make sure your
password is strong enough in terms of length, complexity, and unpredictability and do NOT
disclose it to anyone.

Lost or forgotten passwords

If you have forgotten your password, you must contact your System Administrator immediately
to change it. If you think you may have lost a record of it and someone else could have found it,
then you must inform your System Administrator immediately.

Strong Authentication

Strong authentication can now be employed in addition to the use of an Auditbase password.
When activated in Auditbase administration, the user will be required to be logged into
Windows using the strong authentication method set by the administrator, otherwise they will
be refused access to Auditbase. Strong authentication could mean the use of a Windows smart
card, biometric device or other method of logging into Windows.

Logging into Windows correctly will then allow a User to login to Auditbase.

7.6 Auto-log out (Screen saver)

Auditbase can be logged out temporarily manually or will logout automatically after a selected
time if auto-logout is enabled to ensure that unauthorized persons cannot access the sensitive
data in the system. Screen saver settings can be fixed as a site wide rule or per work station.
Site wide settings are set by the System Administrator and workstation specific settings can be
adjusted by assighed users with an Extended user right. For security reasons, the Screen saver
should be used every time the work station is left unattended. When the screen saver is
activated the Auditbase system is locked by the latest logged on user.

» Activate the screen saver manually by pressing F2.
e For automatic activation, settings should be defined in the System Administration tool.

© Auditdata - 2023, ID: DN02187/06 22



Instructions for use

¢ In the System Administration tool, you can decide if the screen saver automation should
be Disabled or Enabled, and if so after how many minutes the screen saver should be

activated.
e At activation, if no changes have been made, the Login window is presented with

following options for proceeding:
1. Unlock
2. Login
3. Exit

Unlock

¢ By pressing Unlock, the locked connection to the database is re-established (unlocked)
and one of the options from the Application locked window should be selected to
proceed:

e Change user
Another user can log on to the Auditbase system. A warning that the present user’s
unsaved data will be discarded will appear.

NOTE: If you have a dialogue box opened and/or data unsaved and have logged off, it will not
be possible to change the user to another one except for Administrator.

Login

1. Login using a Microsoft Windows account
¢ Double-click on the Auditbase icon on your desktop
¢ Auditbase will log you in using your Windows credentials to the default database

2. Login using an Auditbase account

e Enter user name and password of the user who was logged in at the time for the
screen saver activation. The Auditbase system opens with the same status as
before the screen saver activation.

If you enter the user name and password of a user other than the user who was
logged in at the time of the screen saver activation, Auditbase system opens as a
new instance without any data on the screen from the previous user

Exit

¢ A warning that the user's unsaved data will be discarded appears and the Auditbase

system closes.
e After performing a correct login, the user returns to the Auditbase system and thus to the

window/screen, as it was when the screen saver was activated.

NOTE: The screen saver cannot be activated when Noah is running.
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7.7 Changing the User Interface theme
When starting Auditbase in the new theme, you can always revert to the old theme as needed.

To change the theme:

1. Inthe System toolbar, click the Edit (Gear) icon
2. Goto Current default theme
3. Select Auditbase 5

User SYSTEM ADMINISTRATOR All locations - All departments ﬁf’ -

Laptop synchronization
[No fitter] ~|__|||Fl|| Gener

Prepare off-line database

ariie - Res109 ~| Resdi ResT0
Close current module

Show opened modules

Current default theme L Auditbase &

LChange password Auditbase 5

Open system administration

However, when applying the Auditbase 5 theme, note that after changing the theme:

¢ Only the Ul color palette will change, the icons will not be reverted
¢ Until Auditbase is restarted, some screens will have inconsistent color palette

7.8 Modules

Auditbase consists of several modules that cover various areas of clinic and staff operations,
for instance Booking, Stock, and Journal.

Licensed modules are accessible via the Navigation Pane to the left of the screen.
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7.9 Noah4Auditbase subsystem

Noah is implanted in Auditbase using Noah4Auditbase, a wrapper to the functionality of Noah
4, a unified system for performing client-related tasks.

Note: After upgrading to Noah 4, installation of Noah modules directly from the Auditbase
system has been discontinued. Noah modules can be installed from either the Auditbase
Installation menu or individually with the module installers. Please refer to the Auditbase

25
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System Quick Installation Guide and Auditbase System Installation Guide documents

respectively for detailed instructions.

With the Noah4Auditbase subsystem, you can:

¢ Browse for Noah sessions to open them with the corresponding Noah module.

e Select a Noah module from the list to open it.
¢ Look through the client information.

» After logging on, if Noah does not initialize properly due to poor performing PC, when the

Noah Modules navigation shortcut tries to populate or when going to open Noah, a
message bar will appear stating the problem. A retry of the Noah initialization can be
attempted from here by selecting the Repair button.

7.10 Sorting and saving listing screens

In any screen with a table listing, you can sort the list by a column by clicking on the column

which you wish to sort by.

¢ Hovering over the column title will display a message saying Click to sort column.

Pathway (D | RTT start | Assessment

0002-1700-3544 | 11/01/2011 | 2110217 ik to sort colurnn FE4.

status not 'completion’

0002-1647-2247 | 12/01/2011 | 22/02/2077, Has been breached,

status not ‘completion’

00021721 6948  20/01/2011 | 02/03/2011, Has been breached,
00021719 2022 | 19/01/2011 | 01/03/2011, Has been breached,
00021716 1519 | 18/01/2011 | 28/02/2011, Has been breached,
00021710 1024 | 21/01/20711 | 03/03/2011, Has been breached,
0002 1645 9745 | 11/01/2011 | 21/02/2011, Has been breached,

status not 'completion’
status not ‘completion’
status not 'completion’
status not ‘completion’
status not 'completion’

¢ The first click will sort the column ascending, while the second click will sort the column

descending.

¢ You can also right-click on the column to Select sort order

Fathway 1D RTT start e
| | User view

0002-1700-3544 | 11/01/2011 | W

0002-1647-2247 | 12/01/2011 | M Site default view 7

0002 1736 8567 | 25/01/2011 Mn Application default view 5

0002 1730 4618 | 26/01/2011 | M Select sort order

0002 1730 2111 | 24/01/2011 | M _ 438
Save User view

0002 1729 4479 | 21/01/2011 | M . _

0002 1721 6948 | 20/01/2011 | ¥ save site default view o5

In this window, you can change the default sort order with up to three columns.
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Sort b4

Sort by

Pathway ID - Ascending

# Descending

Then by
Client name -« |# Ascending
Descending
Then by
Active length - =l Ascending
Descending
OK Cancel

Back in the table listing, you can move around with the columns if you want a different view.

¢ Hover the cursor over the bottom line of the column title box and a symbol appears.

| Client name

|Hospital rm.| NHE no.|Active Iength| — Assessment

MR FIRSTNAMEZ3026 LASTNAMEZ3026 | T123026
MR FIRSTMNAMET1941 LASTMAME 1941 T11941
MRS FIRSTNAME19079 LASTMNAME19079 | T119079
MRS FIRSTNAME22281 LASTMNAME3281 T13231
MR FIRSTNAMEZ21335 LASTNAMEZ21335 | T121335
MR FIRSTMNAMEG 746 LASTMNAMEG 746 T167486

479w,
479w,
477 w,
476 w,
478w,
471w,

6d
0d
0d
1d
1d
4d

14%5201['. Has been breached. Mo appt
201212010, Has been breached. Mo appt

030172011, Has been breached, status not ‘completion’
09/01/2011, Has been breached, status not ‘completion’

261212010 Has been breached, status not'completion’
100272011, Has been breached, status not ‘completion”

¢ Once the symbol is displayed, you can click and drag the column to a different location in

the table.

| Client name |Hospital nn.| MNHS n0.|Ac1ive ength| Assessment

MR FIRSTNAMEZ3026 LASTNAMEZ23026 | T123026 479w |6d |14/12/z0010, Has been breached. Mo appt

MR FIRSTHNAME 1941 LASTMAME 1941 T11941 479w |0d |20/12/2010, Has been breached. Mo appt

MRS FIRSTMAME 19079 LASTMAME19079 | T119079 477 w|0d |03/01/2011, Has been breached, status not ‘completion’
MRS FIRSTMAME32581 LASTNAME3281 T13281 476w|1d |09/01/2011, Has been breached, status not ‘completion’
MR FIRSTNAMEZ21335 LASTNAMEZ21335 | T121335 478 w/|1d |26/12/2010 Has been breached, status not 'comp etion’
MR FIRSTNAMEGT746 LASTMAMEGT 4G T16746 471w |dd |[10/02/2011, Has been breached, status not ‘completion’

You can also change the width of the columns by hovering over the separation line between two
column title boxes, then click and drag to make the box either wider or smaller - the box to the

left of the cursor will be affected.

Once you have set up the table listing to your preference, you can save that view as the default

view.

¢ Right-click on the table and choose Save user view.
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Pathway IO RTT start Assessment |

0002-1700-3544 | 11/01/2011 | peato oot e e e e e mioiy 12t comipletion’
User view -

0002-1647-2247 | 12/01/2011 HEErIE Lis not ‘completion’

0002 1721 6948 | 20/01/2011 Site default view Lis not ‘completion’

0002 1719 3022 | 19/01/2011 ' Application default view s not ‘completion’

0002 1716 1519 | 18/01/2011 Select sort order us not 'completion’

0002 1710 1024 | 21/01/2011 : us not ‘completion’
Save user view

0002 1645 9745 | 11/01/2011 _ _ us not ‘completion’
Save site default view

03/111/2010 ot

 |f signed in as an administrator, the site default view can also be saved here.

Note: Certain modules in the application, like Journal, Client information and Booking,
have customisable view options, which are saved by selecting Save window setup under
the View menu. See descriptions of those modules for more information.

7.11 Column sort, word wheel search and scrolling

In most of the windows you can sort the tables based on a column and make word wheel
search within the sorted column. When you point to the column header, you will see a tooltip if
the table supports column sort and word wheel search.

To sort the table, click on the column header.

When you select any row in the table, a search for a matching row is done for each key you
press. In most cases the search string is shown in the status bar of the main Auditbase System
window. To jump to the next row meeting the search string criteria press Ctrl+Return key. To
clear the search string press Backspace.

Mouse scrolling

It is possible to scroll up and down through all tables using the mouse wheel.

7.12 Toolbar and initial screen

All of the icons on the menus have a text label or a tooltip to make it clear what the icon
represents.

The system toolbar contains the following:

e A button to open and close the Navigation Pane. Orange surround if open, grey when
closed.

¢ The selected client’s Date of Birth or Code no. as selected by the System Administrator.

¢ The selected client’s hname.

o Adrop-down list ™! to select from recent clients.

* A button to switch to Client information ~ .
* Abutton to create a client’s treatment summary and show it Z.
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* A button to show client’s latest audiogram =)
e The name of the logged in User.
e The current Location which can also be selected from the drop-down list.

File Edit Wiew Functions

[L]| Client T117438 MISS FIRSTNAME17438 LASTNAME17438 - | & 3 Bl User SYSTEM ADMINISTRATOR Multiple locations... ~ Multiple departments... -

Navigation Thursday 09/01/2020 09:00 - 09:15 | Travy [Mo filter] . | ﬁ| General

* Below this line, the active date, time and resource are shown.
¢ The Clinic filters and Clinic filters set up are also shown.

The default module that will appear when you log into Auditbase can be defined by the user.
Contact your System Administrator to learn how to do this.

The ribbon at the top of the page will display icons within the module you are currently using.
The available icons and functionality will differ depending on the module you have selected.
The ribbons all have icons grouped into tabs of File, Edit, Functions, and View.

The ribbon can be displayed or closed. Double click the selected ribbon tab to close the ribbon.
Double click again to open it.

The ribbon can also be auto closed or opened. First double click the selected ribbon tab in order
to close the ribbon. A single click of the ribbon tab will then open the ribbon temporarily, clicking
one of the icons or clicking elsewhere on the screen will cause the ribbon to close again. This
allows for maxim screen space whilst still allowing ribbon access.

The ribbon groups icons according to their functionality and gives them a title. For instance,
icons relating to search will be grouped and titled as such. They will then be separated from the
next icon group by a divider.

Location and Department can be used for filtering with the Location Filtering licence; this is an
optional extra for Auditbase.

You can make a single selection, select a Location group created by the System Administrator
or make your own multiple selections. A multiple selection is made by selecting the appropriate
option from the Location or Department drop down list. A window will open where selections
can be made by checking the box next to the name of the Location or Department.
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Locations >
Select 3 OK Cancel
| Location

=, Test group123

-3 Location3

[]| =¥, Test group 2

’1 Location1

[~ TawHill

7 Location2

| 4 Testd

Once you have made your selection, OK will close the window or Cancel will close the window
without any changes.

If multiple selections have been made, the Location or Department filter will display Multiple

locations. These choices can be seen by placing the mouse cursor over the filter and viewing
the tool tip. These selections are not saved, so if they are used regularly it is recommended to
make Location groups as these are listed for ease of use.

7.13 Panes

Navigation to the left of the screen holds shortcuts to all Modules, Measurements,
Questionnaires and Tests. These are grouped into panes appropriate to their functionality. The
available panes are shown at the bottom of the Navigation area. These panes will differ
depending on the default view chosen by your System Administrator. Those displayed below are
the default Auditbase 5 grouping.

Individual client
Client pathway view
Clinic management
Stock management
User tasks

PPP lists

The size of the Navigation area can be changed. Drag the Navigation area divider left or right
from its right border edge. Click and drag the border using the mouse to re-size the viewing
panes.

Select a pane appropriate to your needs and it will open showing its shortcuts above. Selecting
a shortcut from this list will cause it to open to the right of the Navigation area.
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Navigation

E}- Favourites

----- = Referral

-5 Booking

-03=] Documents and attachments
----- " Waiting list

= AB Audiogram

&2 NOAH module selection

----- /i Attention list

-~ NOAH session browser

Individual client

-~ Clientinformation -
- Paediatric

~£=| Journal

-BZ] Documents and attachments

55 Referral

-4 8 Clients entries

-2 Device list

@ Observations and procedures

- % Earmoulds

- 24) Hearing Therapist

~[:1] Medical history

5% Direct referral HA (adult)

- ) Tinnitus

- & Surgery

~[£1] HI Satisfaction Questionnaire

B[ Measurements

E-[:i] Questionnaires

(=] Tests

B2 Implant -

Individual client

Client pathway view
Clinic management
Stock management

User tasks

i dlH[E]] 15 1sa Do

PPP list

-
-
o

7.14 User Favourites

From the available Modules, Measurements, Questionnaires and Tests, select shortcuts from
any Pane that are of most use to you and create a Favourites list.
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Go to the Navigation area; select the navigation pane -> right click a shortcut -> click Show in
Favourites.

The selected shortcut will then be copied into your favourites list at the top of the Navigation
area.

Your favourites list will always display at the top of the Navigation area.

Mavigation

-4 Booking

--£3=] Documents and attachments
----- "~ Waiting list

=] AB Audiogram

&) NOAH module selection

----- /i, Attention list

A NOAH session browser

PPP list

2 PPP list
L4 Add client to PPP list

Move your mouse to the divider at the bottom of the Favourites area until it changes to the
cursor in the picture above to expand the pane allowing you to view its entire contents. Both
your favourites list and pane size will be remembered upon logging out of Auditbase.

Right click a shortcut and select Remove from favourites to remove from your favourites list.

To adjust the order the favourites list is displayed in, right click a shortcut and use the Move up
or Move down options to give it a new placing.

7.15 Open, Close and Auto hide the Navigation Area

L Click the icon to the left of the client name and the Navigation area will close. Click the
same icon again to re-open the navigation area. When open, the icon will be outlined in orange.

= When closed, the icon will have a grey surround. Closing the Navigation area allows
maximization screen use.

The Navigation area can be put into hidden mode, allowing screen maximization whilst still
giving easy access to the Navigation area.
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D Click the small pin icon at the top right of the Navigation pane, the pin now displays
horizontal. Hidden mode is switched on. Move away from the Navigation Pane and it will hide
itself.

Take your cursor back to the Navigation area, hover over the words Navigation. The Navigation
area displays again.

When unhidden, you can select shortcuts from the Navigation area by moving your cursor into
it and making your selection.

When using the auto hide function, the navigation open and close icon will be inactive. You
will need to use the pin icon to permanently open the navigation pane before the icon will
become active again.

D Cause the Navigation pane to remain open by again clicking on the pin at the very top of the
Navigation area. The pin now displays vertically.

When the Navigation area open/close symbol is clicked and Navigation auto hide is in use, a
warning message will appear. To prevent the message appearing on future occasions, check
the Don’t show this message again box. You can reset all messages to show again from within
System Administration -> User settings -> User specific options -> Reset all checkboxes ‘Do
not show this message again’ to show again.

Permanently close the Navigation area by clicking on the D at the top right of it. Open the pane
again by clicking the icon to the left of the client name.

7.16 Pane Configuration

The panes in the Navigation area can be configured to suit individual user preference. At the
bottom of the Navigation area and to the right of the last pane, is a small downward pointing
arrow ~ . Click this to open options for configuring the panes.

Selecting Show Fewer Buttons will minimize the last pane title to just an icon at the bottom.
Select Show Fewer Buttons again to minimize the next, last pane title. Clicking, Show More
Buttons will cause them to be replaced as full headings.

Show More Buttons
¥ Show Fewer Buttons
Mavigation Pane Options...

Add or Remowve Buttons 4

Hover over Add or Remove Buttons and a secondary menu will open. From the secondary
menu, you can remove headings from the list completely. Replace the removed headings at any
time by selecting them again in the same menu location.
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Individual client

Client pathway view
Clinic managerment
Stock management

User tasks

i5d B s sy I

PPP list

-
-
-

Selecting Navigation Pane Options from the menu allows you to adjust the order the headings
are displayed in, as well as removing and adding headings to the list.

Mavigation Pane Options -
Display buttons in this order
B Individual client M U
| i Client pathway view e
M Clinic management

Stock management It

User tasks

PPP list Reset

oK Cancel

Selections made here are user unique and will be remembered by Auditbase upon logging out.

Navigation panes and their contents can be decided upon by the System Administrator,
therefore allowing limitation of what users may see and access. The System Administrator can
decide who accesses what by individual user, role or system wide access.

Keyboard shortcuts are shown on mouse-over in the Navigation pane.

7.17 Printing and output redirection

Auditbase System can set up a selection of default configurations including all printouts. Users

can select one of these configurations as their workstation default, thus controlling how printing
works.

For all system printouts in Auditbase, your System Administrator can configure their output
redirection. The redirection option can be defined for each report separately, which means that
the options may vary for different reports. The following options are available:

¢ Send the printout to the application default printer (no redirection).

¢ Send the printout to the Windows default printer.

¢ Show Windows Print dialogue before printing. In the dialogue, you can select printer
and number of copies.
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¢ Send the printout to a file.

¢ Send the printout to a file and attach the file to a new e-mail message. Additionally, for
some reports processed with this option, the system copies the recipient e-mail address,
if a relevant address exists in the system.

Note: To send a printout to a file and to send a printout to an email, the Printing/Output
extension module needs to be licensed. Microsoft Office must be installed on the user’s
PC, and the “Microsoft Office Document Image Writer” printer must be available.

User reports cannot be redirected.

The configuration described above is performed by the system administrator.

7.18 Help
Q2
T Contents I
Documentation 4
Support 4
About 4

The Help menu item has separate options for help file Contents, user guides or other
Documentation, and how best to access Support.

7.18.1 Contents
[&' Auditbase User Guide - O X
&
Hide Locate Print Options
Contents llndex ] §earch] Ta)
@ Clients and Client informatio I ntrOd UCtlon
@ Referrals
@ Waiting lists ) ) ) : )
@ Client lists/Trials Audltbage Is an integrated information system
@ Booking for hearing clinics. The system seeks to
@ Referring agents integrate all the working operations of a
@® Measurements hearing clinic and to collect in one database
@ Client pathway overview . . .
@ Eamoulds all data concerning clients, hearing
@ Paediatric Module instruments, administration, etc.
@ Stock
g i"“’”a' The Auditbase system has been designed as a
i t . . .
& ln:a:icrze” sammary Microsoft Windows based client-server
@ Repair complex program for application in PC based
@ Questionnaires networks.

[?] Medical History
@ Other Features

Audithase consists of a number of modules,
@ Documents and attachment

& Tests which reflect the various working operations
1? @ Aditans Imnlant madula N v at a hearing Audiology clinic. Vv
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The entire help contents are displayed. Iltems can be searched for or individual items can be
expanded to show subjects. The content mirrors the User Guide.

7.18.2 Documentation

22

Contents
Documentation
Support

About

»

Change guides
Release documentation

Optional module info

User and administration guides

Reporting documentation
Database documentation
Installation documentation

Auditbase What's new

A number of documents can be viewed by selecting Documentation and then further selecting
from the selection of documents. Double-clicking will open any of the individual documents if a

PDF reader is installed.

7.18.3 Support

1:1—"-

—_— Contents
Documentation
Support

About

Profiling

Profiling 4
Rernote support

Electronic support report

Open Log Folder

Contact us

For details, see the section on Profiling.

Remote support

¢ Selecting this option will launch the TeamViewer electronic support application.
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[ pisclaimer >

Use of Auditdata Remote Support with your Auditdata support partner must be approved
by your local IT department.

Auditdata provides tools only to be used within national and local rules for data security
and remote access to computers. Itis your responsibilty to ensure that you are
complying with these rules.

By dicking "Accept’ you accept that it is your responsibilty to ensure compliance with
national and local rules and that all necessary steps have been taken to achieve
compliance.

Please note that the above-shown disclaimer has no connection with TeamViewer Germany
GmbH. It was individually defined by a TeamViewer user.

Accept I Dedine I

Accept the disclaimer if your IT department will allow you to use the TeamViewer.

[5] auditdata Remot...  — >
Auditdata
Allow Remote Control o

Please tell your Auditdata support partner the
following |D and password te connect to your
computer.

Your ID

444 662 078

Password

bgs514

@ Readyto conned (secure connection)

Your Auditdata supporter will require the ID number and Password that are displayed.

Electronic support report

¢ Selecting this option will produce an electronic report that can be sent to Auditdata.
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Electronic support report >

The "Electronic support report™ contains data collected by the system automatically and stored in files on disk.
These files should be sent to your Auditdata support engineer. The location of the files will be:

Cilsers\ANDSHU\Deskiop\Electronic_support_report_2020-01-09-12 27

Collect data Close

Make a note of where the file is stored to, it should be your desktop, and then press Collect
data. Once the information is collected, a confirmation message will be displayed.

The support data have been collected

oK

A folder will be created on your desk top, containing two files. These files may be emailed to
Auditdata to help resolve issues.

Open Log Folder

Open Log Folder in the Help menu will open a window where certain log files are stored. You
may be asked by Auditdata support to send these files if you have reported an issue. No client
data is contained in these logs.

Contact us
Contact us will open the contact page on the Auditdata website.

7.18.4 Profiling

Profiling is a support option in Auditbase, allowing users to collect information for developers
about how the application is running.

It is practical when troubleshooting problems as profiling logs all system activity that can later
be reviewed by the support team or developers. IMPORTANT: No client information is recorded.

Users can access Profiling from the Help menu in the System toolbar:
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All departments - %X 2

Contents

Documentation 4

Suppoert 7 Profiling Y Start

About 4 Remote support Suspend
Electronic support report Continue
Open Log Folder Stop
Contact us Settings

Run at startup
Open Log folder

The following controls allow management of the Profiling functionality:

1. Start: launches Profiling, which may potentially slow down the application

2. Suspend: temporarily stops Profiling if performing other tasks requires full system
capacity

Continue: restarts profiling that has been suspended

Stop: quits the Profiling mode

Settings: contains additional Profiling settings

Run at startup: launches Profiling at the next Auditbase startup

Open Log folder: opens the folder with Profiling logs

NOoO oA

Whenever Profiling is enabled, the corresponding banner will be shown. Users can obtain more
information by clicking the Info button, or alternatively disable application logging by clicking
Stop.

-8 = |B|user SYSTEM ADMINISTRATOR All locations ~ All departments L - 1

Warning

f System profiling is running. This could potentially decrease application performance. Stop

Since turning on Profiling may affect the performance of the application, it is recommended
that users go into the Profiling mode only when instructed to do so by Auditdata support
specialists.

Settings

More advanced configuration options are accessible from the Settings window. Here you can
configure the following:

1. Folder for logs: use the default or specify your own folder

2. Level: define the level of profiling. Extended level is recommended

3. Run on the next Auditbase start: enable the launch of Profiling as soon as you start
Auditbase

4. Stop at: define the date when Profiling will be turned off. Double-clicking inside the box
inserts the current date that can be modified as needed
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5. Automatically delete log files older than a specified count of days
6. Keep file size not more than a predefined size in MB

Profiling settings et

Apply Close

Folder for logs C\ProgramDatalAuditdatatauditbas el

Level Extended - Run on the next Auditbase start
Stop at

Automatically delete log files 0 0 means no automatic deletion
older than (days)

Keep file size not more than (MB) 50 0 means no size restriction

7.18.5 About Noah

Use this menu item to view license information on the installed version of Noah. The
information includes customer name, Noah serial number, license type, days left before license
expiration, and number of users licensed to access the system.

7.18.6 About Auditbase System

Use this menu item or press F1 to see specific information on running the Auditbase System
version.

You can see the revision number, build number, customer name, license ID, and the number of

users licensed to access the system.

Version 6.5.0.0

o) Auditbase

System is licensed to

(12 users)

Product name (Type label}: 2003 Auditbase
UDI-DI: 05711781002064

(€ I Auditdata A/S
Widersgade 10B, 1408 Kgbenhavn K, Denmark

AUDITDATA Close

Copyright ® 2023 Auditdata. All rights reserved.

For more information, see Appendix B.2 Label signs interpretation.
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7.19 Accessibility options
Waiting list

(Accessibility option) With the User option in Admin Waiting list type affected by refresh rule
checked and Refresh Waiting list immediately after changing filter criteria? set to No, the
user can step through the waiting lists and have them read by a screen reader without selecting
them. To select it, press Enter. To open the drop-down list, press Alt + ArrowDn.

Booking - Timeplan

Enable the User option in Admin Show hours and minutes in every timeslot to have a screen
reader read the time for each row.

With the Do not refresh Timeplan upper screen until selection confirmed in lower screen
option enabled, the Resource is not changed in the upper screen until Enter on the Resource
row names in the lower section is selected. This must be done before the user selects the
Resource they want to view.

To ensure a screen reader can read the correct Resource name in the lower table, take care to
allow enough time between selecting each resource.

(Accessibility option) Press Alt+C to move focus to the calendar and here you can move
between dates with arrows and PgUp/Dn keys.

Client search

With the user option in Admin "Search clients: Display message with search results after
filling the table (Accessibility option)" checked, a message box displays the number of found
clients upon completed search for a screen reader to read.

Use the space key to toggle the selection check mark.

Everywhere

(Accessibility option) Press F6 to call up a small dialogue with the selected patient's ID and
name that a screen reader can read.

Client’s entries

(Accessibility option) The column with Appt. Symbol can be read by a screen reader if moved to
the leftmost position in the saved user view.
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7.20 Full operations guidance

Full operational guidance is available in Auditbase User Guide. This document is available from
the Help menu described above.
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8 Troubleshooting guide

If you have any problems with installing or running the software, please go through this guide
first before contacting a Support/HOT-line.

Please verify that installation prerequisites are satisfied. For details, see Appendix A.

If all installation prerequisites have been met and you still have issues with your software,
please refer to the tables below for the solution of your problem.

SQL errors

Issue

Solution

9268 - Cannot connect

Contact Local IT to check the network, server and Gupta
SQLBase service on the server.*

9024 - Session ended
abnormally

Contact Local IT to check the network, server and Gupta
SQLBase service on the server. *

9028 - Session ended
abnormally

Contact Local IT to check network, server and Gupta SQLBase
service on the server. *

1102 - Security violation
attempting to access

Select the Error to show which table is affected. Assign
appropriate table rights in the System administration tool ->
Users, security and views -> User administration and security
> User rights and setup -> Roles.

803 - Fatal SQLBase System
Failure

Stop all Auditbase activity. Contact Auditbase support.

805 - Insert/update of
unigue constrained columns
with duplicate data

Contact Auditbase support.

* If no issues are found, contact Auditbase support at support@auditdata.com

Noah issues
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Issue

Solution

For versions below 5.4.2 only.

e Using Phonak Target 7.1, Hearing Aid
serial numbers cannot be read.

Apply for upgrade to support@auditdata.com

Noah token error when logging into Auditbase.

Change your password from Booking ->
System setting -> Change password. Repeat
if the message appears again.

¢ The password cannot be changed by
the system administrator.

For Noah versions below 4.13 (Auditbase
version 6.1.0).

¢ Noah validation fail (500)

See Noah's Data Validation Errors

Noah problems after Windows 10 Upgrade.

¢ A problem with Noah initialization after
an upgrade of Windows 10 (e.g., from
18009 version to 1903), irrespective of
the version of Windows 10.

e An upgrade removes “Full control”
permission from “Authenticated Users”
in the HKEY_
USERS\.DEFAULT\Software\AuditData\
NoahDBlInterface registry folder used for
connection to Noah.

There are 4 ways to fix the problem:

1. Add “Full control” permission for
“Authenticated Users” in the registry
folder HKEY_
USERS\.DEFAULT\Software\AuditData
\NoahDBInterface.

1.1 Open the registry editor.

1.2 Goto HKEY_
USERS\.DEFAULT\Software\AuditData
\NoahDBInterface.

1.3 Right-click on the folder
NoahDBlInterface and select
“Permission”.

1.4 Click “Add” to add “Authenticated
Users”.

1.5 Add “Full Control” for
“Authenticated Users” and click “OK”.

2. Run
AddNoahPermissionToRegistry.exe as
Administrator from the folder
AuditBase CD
image\Auditbase\NOAH\RestoreRegis
tyPermission.
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Issue

Solution

3. Copy all files from AuditBase CD
image\Auditbase\NOAH\RestoreRegis
tyPermission, read the file readme.txt
from the attached archive and run
AddNoahPermissionToRegistry.bat as
Administrator.

4. Reinstall Auditbase.

Miscellaneous

Issue

Action

Auditbase is compatible with
Windows 10 from version 6.x.x
only

To upgrade, apply by email to support@auditdata.com

More users logged in than
allowed by licence

Check connections in the System administration tool ->
Tools menu item -> Monitor connections.

Disconnect selected users.

Letters for keyboard shortcuts
on buttons and tabs missing
underlines

This is now controlled by the settings in Windows. If letters
are not underlined, then:

e On Windows 10, go to Settings -> Ease of Access ->
Keyboard, then switch on the "Underline access keys
when available" option.

e On Windows 7, go to Control panel -> Ease of Access
-> Change how your keyboard works, then switch on
the "Underline keyboard shortcuts and access keys"
option.

Incorrect version of gswag32.dll

* Copy the files gswag32.dll, gswdll32.dll,
from: C:\Program Files (x86)\Gupta\Runtime62\

o Paste to the folder: C:\Windows\SysWOW®64\

Repeat on each PC where the error appears.
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Issue

Action

Installing 64-bit ODBC drivers

For each PC where you need to use the 64-bit ODBC
connection:

1. Make sure ‘Enable Driver’ is NOT ticked in the

. Install the C++ 64-bit runtime libraries by running the

. Run ‘Gupta SqlBase 64-bit drivers.msi’ to install the

4. Manually create the 64-bit ODBC connection:

Auditbase Administration (as this is just for the 32-bit
ODBC connection). It will not be ticked by default.

file veredist_x64.exe
Also available from:

¢ Download Microsoft Visual C++ 2008 Service
Pack 1 Redistributable Package MFC Security
Update from Official Microsoft Download
Center (choose the x64 version)

¢ Right-click and select ‘Run as Administrator’ to
install

Auditbase 64-bit ODBC drivers.

These drivers are in the Auditbase installation, which
can be found on your sever at:

¢ \\twhaudioO1\AB Install\Auditbase
6.0.3.2.12346\Database\SqlBase drivers x64
setup

¢ Open the 64-bit ODBC Administrator from
C:\Windows\System32\odbacad32.exe

¢ Select the ‘User DSN’ tab and select ‘Add’

o Select the ‘Gupta SQLBase 11.7 (64-bit) driver,
then click ‘Finish’

e ‘Configure’ the data source as shown below

¢ Press ‘Test Connect’ to check if it is working
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Issue

Action

B azic Propertiez
Data Source Mame [DSH)
|ﬁuditbase-DDEEEd |

[ escription

SOLBase Databaze Mame Server Mame
|ﬁ3«Bﬁ3«SE | |SEFNEF|1 |

Authentication Properties
|Jzer Mame Pazzword
|SYSADM | | sessasess |

Advanced Properties
|zolation Lewvel
Release Locks w

Input Meszage Size [bytes)  Lock Timeout [geconds]
|2nnn | |3uu |

Canfig Filenarne [IMI]
|C:'\F'rnglam Files [#86]\Gupta\Team Developer 7.24:ql.ini |

Additional zettings [key=value[key=valug] . ]

Test Connect ] Cancel Help

Once the connection is working, you should be able to
connect to the Auditbase ODBC from 64-bit applications
(e.g., MS Access).

Problem printing RPT reports
from AB with Crystal 11
installed. QRP reports are
printed without any issues.

The problem is caused by an incorrect Crystal XI runtime
which might be installed together with some MS products.

To resolve:
1. Uninstall Crystal Reports XI runtime

2. Install Crystal Reports XI from Auditbase install
media \Auditbase\CRXIRuntime.msi
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9O Operator roles and activities

9.1 Operator roles

The following are the operator roles generally expected to be involved in distribution, service
and other activities with Auditbase.

¢ Application distribution - responsible for the distribution of desktop applications
(including through MSI packaging if required).

¢ Auditbase administrator - responsible for configuration and setup of Auditbase including
user creation, administration and authorisation.

¢ IT security - responsible for maintaining IT security.

+ Database administrator - responsible for database backups.

¢ Clinical Safety Officer - responsible for clinical safety.

9.2 Operator activities and recommended frequency

administrator

permissions through modifying the relevant
user roles

Operator role Activity Recommended
frequency

Application Client application installation On installation

distribution

Auditbase Configuring user permissions; updating their | During user

onboarding and after
feature updates

administrator

password handling

Auditbase Revoking users Users leaving
administrator

Auditbase Evaluation of audit logs As required
administrator

Auditbase User training on account security and During user

onboarding and after
feature updates

administrator

IT security Keeping anti-virus and malware protection Daily
up-to-date

IT security Ensuring operating system security patches Weekly
are up-to-date

Database Monitoring backup Daily
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Operator role Activity Recommended
frequency

Database Backup verification As required

administrator

Database Preparation for backup restoration As required

administrator

IT security/ Informing Auditdata regarding relevant As required

Auditbase security incidents

administrator

Auditbase Informing Auditdata regarding relevant As required

administrator/ clinical safety incidents

Clinical Safety

Officer

IT security Exchange of keys or certificates As required
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Appendix A

A It is essential that the Business Process ensures that adequate resources are provided for

client PCs according to the minimum system requirements below.

The Auditbase pre-install or pre-upgrade checklist must be accurately completed.

A.1 Server specifications

A.1.1 Hardware requirements

Virtualised servers and SAN storage are fully supported by Auditbase.

The minimum specification is aimed at existing installations being upgraded and should be
discussed with Auditdata support. New installations should always use the recommended
specification or above depending on the number of users.

Hardware Minimum Recommended Comment
Component
1-10 concurrent users
Processor Xeon Dual Core | Xeon Dual Core 2.0 Virtualised is supported
1.5 GHz GHz
e.g.,, E3v31l e.g., E3 v31 family or
family above
RAM 6 GB 12 GB
10 - 200 concurrent users
Processor 2 Xeon Quad 2 x Xeon Quad Core Virtualised is supported
Core 2.0 GHz 2.0 GHz
e.g.,E7v21 e.g., E7 v21 family or
family above
RAM 8 GB 12 GB
All users
HDD Type SSD Fast SSD Fast SSD significantly
improves performance
HDD Space DB(s) sizex3 + 5 | DB(s) size x5 + 10 GB | Combined active DB size.
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Hardware Minimum Recommended Comment
Component
GB
USB 2.0 3.0
A.1.2 Software requirements
Software Description Comment
Component
Operating System | Windows 2019 Server For 64-bit Server 32-bit
) application support must be
Windows 2016 Server enabled in order to run essential
Windows 2012 Server tools.
Windows 2022 Server All Microsoft Updates should be

installed.

Windows 2022 Server is only
supported for SQLBase 12.3.0

Configuration

Configure as ‘Application Server’ not
‘File sharing’ where available.

‘File sharing’ will reserve 41% of
system memory.

Database engine

and 2019)

Gupta SQLBase 12.2.1
Gupta SQLBase 12.1.3

Gupta SQLBase 11.7 SP4 (not
supported on Windows Server 2016

Supplied by Auditdata.

Minimum one port must be
available for connecting to
SQLBase, typically 2155.

Active Directory Optional.

Auditbase integration with Active
Directory was tested on Windows
server 2016, Active Directory
Schema 87.

Back-up facilities

A document detailing recommended
backup procedures can be requested
through the normal Auditdata contact
or via e-mail request to
support@auditdata.com.

Auditdata can provide
recommendations on how to
perform backup but cannot
implement or service these
routines.*
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* please be aware that Auditbase server backup is entirely the responsibility of the local IT department and that
Auditdata cannot be held liable for any loss of data resulting from inadequate or inaccurate backup routines.

A.2 Client specifications (including Noah installation)

A.2.1 Hardware requirements

Hardware Minimum Recommended | Comment
Component
Processor Core ib Corei7
RAM 32 bit: 3.5 32 bit: 3.5 GB A high level of memory is additionally

GB _ needed by Noah fitting modules. If other

64 bit: 8 GB licati , .
64 bit: 4 GB applications or services are running
) simultaneously more will be required.

HDD SSD 2 GB free plus @1 Gb per Recommended by HIMSA.

Noah module.
Network 100 Mb/s 1 Gb/s Network requirements, see below.
Adapter
Graphics Widescreen | Widescreen 16:9 | The minimum resolution for Auditbase is
Adapter 16:9 1920 x 1080 due to be increased to 1920 x 1080 in the

near future, so please bear this in mind

1366 x 768 when planning hardware upgrades.

A.2.2 Software requirements

Software Minimum Recommended Comment

Component

Operating Windows 10 | Windows 10 (64 All Microsoft Updates should be
System (64 bit)* bit)* installed

Windows 11* | Windows 11* *1) Contact the manufacturer for
module or audiometer panel
support;

2) Auditbase was tested on versions
Win10 (22H2), Win10 (21H2),
Win11 (21H2), Winl11 (22H2).

© Auditdata - 2023, ID: DNO2187,/06 A-3



Instructions for use

Software Minimum Recommended Comment

Component

Ghosting Ghosting images of Windows are not supported due to SID issues.
Document Microsoft Word 2007 - 2019, 365 Pro Plus (tested with version 1910).
editor

Noah modules

Must be Noah4 certified.

Web Browser

Not required.

Java

Not required.

.Net

4.6.2 (installed with Windows 10).

A.3 Client specifications (without Noah installation)

A.3.1 Hardware requirements

Hardware Minimum Recommended | Comment
Component
Processor Core i3 Core ib
RAM 32 bit: 3.5 32 bit: 3.5 GB If other applications or services are
GB A bit running simultaneously more RAM will be
. 64 bit: 8 GB required.
64 bit: 4 GB
HDD 1 GB free SSD 3 GB free
Network 100 Mb/s 1Gb/s Network requirements, see below.
Adapter
Graphics Widescreen | Widescreen 16:9 | The minimum resolution for Auditbase is
Adapter 16:9 1920 x 1080 due to be increased to 1920 x 1080 in the
near future so please bear this in mind
1366 x 768 when planning hardware upgrades.
or above
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A.3.2 Software requirements

Software Minimum Recommended Comment

Component

Operating Windows 10 (64 Windows 10 (64 | All Microsoft Updates should be
System bit) * bit) * installed

Windows 11* Windows 11* *Auditbase was tested on versions
Win10 (22H2), Win10 (21H2), Win11
(21H2), Winl11 (22H2).

Ghosting Ghosting images of Windows are not supported due to SID issues.

Document Microsoft Word 2007 - 2019, 365 Pro Plus (tested with version 1910).
editor

Web Browser | Not required.

Java Not required.

.Net 4.6.2 (installed with Windows 10).

A.4 Security specifications

A.4.1 Encryption

¢ Network traffic between the Auditbase database and client PCs can be encrypted using
TLS1.2. It is recommended for security that this is requested.

¢ The Auditbase SQLBase database can be encrypted. It is recommended for security that
this is requested. Note that this may have a detrimental impact on performance.

e HL7 Interfaces between Auditbase and hospital systems are required to be secured by
the customers own traffic encryption and protection within their private network domain.

A.4.2 Anti-virus and anti-malware

¢ It is essential for security that anti-virus and anti-malware protection is installed on every
PC where Auditbase is used. This protection must be updated on a regular basis.

 [tis essential for security that in order to mitigate risks if a PC is infected by a virus or
malware that users do not have any Administrator level rights in Windows which could be
taken advantage of by the virus or malware.
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A.4.3 Windows authentications and passwords

¢ |t is essential for security that a method of strong authentication for Windows login is
employed when Active Directory Windows login is enabled for Auditbase.

* [tis essential for security that a policy for keeping Windows passwords secure is
enforced.

A.4.4 Security of printouts

e For security, it is advised that a cover page that could include "PATIENT CONFIDENTIAL
INFORMATION" is configured on printers where printouts from Auditbase are made.

A.4.5 Port scanning

¢ Auditdata suggests which ports to use for Auditdata applications. These may be changed
by the customer after discussion with Auditdata support staff on how to reconfigure the
application. The customer is responsible for ensuring that port scanning is performed on
all relevant network interfaces.

A.5 Network specifications

A.5.1 Network requirements
Bandwidth: Approximately 10Mbit is required per user for the best working experience.

Latency: Performance decreases as latency increases. A latency of 0-20ms is preferred; a
latency over 35ms will result in real delays noticeable by users. Latency over certain high levels
(100ms/200ms depending on the network type and application area) will result in connection
loss and the application will need to be restarted.

Loss of connection: Network connection must be maintained at all times otherwise the
application will need to be restarted. Auditbase connection licensing does not support
connection loss and licence number violation may occur in this circumstance.

Loss of packets: TCP handling will cope with a limited loss of packets. A 5% loss will result in a
noticeable slowdown and around 50% will result in a loss of connection.

A.5.2 Naming Client workstations

Recommendation: Names of workstations should have unique last 8 characters. This is
needed for efficient tracking of the Auditbase licences in use and, potentially, freeing hanging
connections of the same user from the same workstation.

© Auditdata - 2023, ID: DNO2187,/06 A-6



Instructions for use

A.6 Equipment and Network hazards and configuration
changes

On any equipment and network configuration change, or any patching to, for instance,
Windows, anti-virus, or firewall software, the customers are strongly advised to carry out
changes in a way, so that the minimum requirements described above are still met.
Consideration must also be taken that any changes or patches to the above will still support the
security goals and security capabilities of the system.

If Auditbase is run on equipment or network not satisfying minimum requirements, that can
cause the following consequences:

° Low system performance, which can cause delays in patients’ treatment and information
disclosure;
° System crash, which can cause loss of unsaved data.

In general, customers are suggested, that using the system in an environment not satisfying
minimum requirements can cause previously unidentified risks to patients, users, and third

parties. Customers are responsible for analyzing and evaluating risks related to providing or
changing their IT infrastructure.

Changes to the IT-Network include:

1. Changes in IT-Network configuration;

2. Addition of items (hardware and/or software platforms or software applications) to the IT-
Network;

3. Removal of items from the IT-Network;

4. Update of hardware and/or software platforms or software applications on the IT-
Network;

5. Upgrade of hardware and/or software platforms or software applications on the IT-
Network.
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A.7 Information flow

A.7.1 Information flow - Diagram

AuditBase client application
(PC)

1

v

2 E

AuditBase Laptop application
Includes local database

A

Main database

L

5MS5

5
E ‘
—_— bl
AuditBase server applications

g

E-mails

A.7.2 Information flow - Assets

£

External systems

Name

Description

Personal data Storage

Auditbase client
application (PC)

Auditbase client Windows GUI
application. Operates in the local
area network, connects to the
Main database.

Yes. No

Users read and
enter personal
data using this
application.
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Name Description Personal data Storage
Auditbase Auditbase client application Yes Yes
Laptop configured for operation outside
application, the local area network.
including Local _
database Include§ Local database engine
for storing data.
Main database | The database where all data are Yes Yes
stored.
The owner of the database is the
Customer; keeping the data is the
Customer’s responsibility.
Local database | The database is used as a part of | Yes Yes
the Auditbase Laptop application.
Contains data about a very limited
number of patients.
The owner of the database is the
Customer; keeping the data is the
Customer’s responsibility.
Auditbase Various standalone applications Yes Depends on the
Server used for interfacing purposes. used interfaces
applications
External Auditbase has interfaces to Yes Yes
systems external Information systems.
That can include:
° Hospital Patient
Administration System (PAS)
for exchanging
demographics and
appointment information.
° Document storage system.
° Etc.
SMS SMS sent to patients for Configurable On the patient’s

appointment reminders.

mobile phone
according to their
configuration
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Name Description Personal data Storage
E-mail Documents e-mailed to patients Yes Receiver
and other parties. responsibility.

A.7.3 Information flow - Description

Number

Description

Personal data
processed

Auditbase client Windows GUI application reads and writes data
to the main database; operations are done in the local area
network.

Yes

The Auditbase Laptop application (configured for operation
outside the local area network) reads data from the main
database for further copying it to the Laptop database; it also
synchronizes modified data to the main database. These
operations are done in the local area network.

Yes

Auditbase Laptop application (configured for operation outside
the local area network) reads and writes data to the Laptop
database; operations are done inside a laptop PC.

Yes

Auditbase client Windows GUI application requests data from
the Server standalone applications and receives a response.

Yes

Auditbase server applications read and write data to the Main
database for interfacing needs.

Yes

Auditbase server applications exchange data with external
systems.

Yes

Auditbase server application sends SMS to patients using E-mail
or Web services provided by the Customer.

Configurable

Auditbase server application sends E-mail to patients and other
parties using the e-mail service provided by the Customer.

Yes
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Appendix B

B.1 Manufacturer and System Data

The SaMD Auditbase System is manufactured and sold in the EU by:

Head office:

Auditdata A/S

Wildersgade 10B 1408 Kgbenhavn K Denmark
Phone: +45 70203124

www.auditdata.com

R&D site:

Auditdata Ukraine TOV, Ukraine
04053, Kyiv, str. Sihovykh Striltsiv, 23a
Phone: +38 044 284 18 65

www.auditdata.com

2003 Auditbase

Documentation version:
Auditbase Help System version (IFU) DN0O2187/06
Symbols used on the system, its packaging, and in documentation:

See the section "Symbols used" for an overview of symbols used.
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B.2 Label signs interpretation

B.2.1 Label sample

Product name (Type label): 2003 Auditbase
UDI-DI: 05711781002064

Version 6.5.0.0

o) Auditbase

c€ I Auditdata A/S
Widersgade 108, 1408 Kgbenhavn K, Denmark

AUDITDATA

B T

Copyright @ 2023 Auditdata. All rights reserved.

Close

B.2.2 Label interpretation for MDR

NOTE: The licences list is dynamic and varies according to the licence content for each

custometr.

Auditbase

Type of the device

Version 6.5.0.0

Device version

wl

Manufacturer’'s address

ce

CE marking

2003 Auditbase

Product name (type label)
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